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Caution: US Federal law restricts this device to sale by or on the order of a physician. 

 

© 2011, Welch Allyn. All rights are reserved. No one is permitted to translate, reproduce or duplicate this 
manual or any part thereof, in any form, without prior written permission from Welch Allyn. Welch Allyn 
assumes no responsibility for any injury to anyone, or for any illegal or improper use of the product, that 
may result from failure to use this product in accordance with the instructions, cautions, warnings, or 
statement of intended use published in this manual. Unauthorized copying of this publication may not only 
infringe copyright but also reduce the ability of Welch Allyn to provide accurate and up-to-date information 
to users and operators alike. 

Welch Allyn®, CardioPerfect®, and SpiroPerfect® are registered trademarks of Welch Allyn.  

PerfectLink® is a registered trademark of Welch Allyn. 

Software in this product is copyright Welch Allyn. All rights are reserved. The software is protected by 
United States of America copyright laws and international treaty provisions applicable worldwide. Under 
such laws, the licensee is entitled to use the copy of the software provided on the original distribution 
medium. The software may not be copied, decompiled, reverse-engineered, disassembled or otherwise 
reduced to human-perceivable form. This is not a sale of the software or any copy of the software; all right, 
title and ownership of the software remains with Welch Allyn.  

The information contained in this manual is subject to change without notice.  

All changes will be in compliance with regulations governing manufacture of medical equipment. 

The printed version of this document may be out of date. Always refer to the file on the CD for the latest 
information. 

User responsibility 
This product is designed to perform in conformity with the description thereof contained in this manual and 
accompanying labels and inserts, when assembled, operated, maintained and repaired in accordance with 
the instructions provided. A defective product should not be used. Parts that are broken, plainly worn, 
missing or incomplete, distorted or contaminated should be replaced immediately. Should any repair or 
replacement become necessary, we recommend that service be performed at the nearest approved 
service center. The user of the product shall have the sole responsibility for any malfunction, which results 
from improper use, faulty maintenance, improper repair, damage or alteration by anyone other than Welch 
Allyn or their authorized service personnel. 

Accessories 
The Welch Allyn warranty can only be honored if you use Welch Allyn approved accessories and 
replacement parts. 

 
Caution: Use of accessories other than those recommended by Welch Allyn may compromise 
product performance. 
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Warranty, service, and spare parts 

Warranty 
All repairs on products under warranty must be performed or approved by Welch Allyn. Unauthorized 
repairs will void the warranty. In addition, whether or not covered under warranty, any product repair shall 
exclusively be performed by Welch Allyn certified service personnel. 

Assistance and parts 
If the product fails to function properly or if assistance, service, or spare parts are required, contact the 
nearest Welch Allyn Technical Support Center.  

USA 
Latin America 
European Call Center 
United Kingdom 
France 
Germany 

1-800-289-2501 
(+1) 305-669-9003  
(+353) 46-90-67790  
(+44) 207-365-6780 
(+33) 1-55-69-58-49  
(+49) 695-098-5132 

Canada  
South Africa 
Australia 
Singapore 
Japan 
China 

1-800-561-8797 
(+27) 11-777-7555  
(+61) 2-9638-3000  
(+65) 6419-8100 
(+81) 42 703 6084  
(+86) 21-6327-9631 

 

Before contacting Welch Allyn it is helpful to attempt to duplicate the problem and to check all accessories 
to ensure that they are not the cause of the problem. 

When calling, please be prepared to provide: 

• Product name, model number, and complete description of the problem 

• The serial number of your product (if applicable) 

• The complete name, address, and phone number of your facility 

• For out-of-warranty repairs or spare parts orders, a purchase order (or credit card) number  

• For parts orders, the required spare or replacement part number(s) 

Repairs 
If your product requires warranty, extended warranty, or non-warranty repair service, call the nearest 
Welch Allyn Technical Support Center. A representative will assist you in troubleshooting the problem and 
will make every effort to solve it over the phone, avoiding potential unnecessary return.  

If a return cannot be avoided, the representative will record all necessary information and will provide a 
Return Material Authorization (RMA) number, as well as the appropriate return address. A Return Material 
Authorization (RMA) number must be obtained prior to any return. 

Welch Allyn does not accept returned products without an RMA. 

Packing instructions 
If you have to return goods for service, follow these recommended packing instructions: 

• Remove all hoses, cables, sensors, power cords, and ancillary products (as appropriate) before 
packing, unless you suspect they are associated with the problem. 

• Wherever possible use the original shipping carton and packing materials. 

• Include a packing list and the Welch Allyn Return Material Authorization (RMA) number. 

It is recommended that all returned goods be insured. Claims for loss or damage to the product must be 
initiated by the sender. 



 
 CardioPerfect Workstation 
  

 

DIR 80013928, Ver. D  4 / 59 

 

Limited warranty statement 
Welch Allyn, Inc., warrants that the CardioPerfect Workstation computer based product you have 
purchased meets the labeled specifications of the Product and will be free from defects in materials and 
workmanship that occur within 1 year after the date of purchase. Accessories used with the Product are 
warranted for 90 days after the date of purchase.  

The date of purchase is: 1) the date specified in our records, if you purchased the Product directly from us, 
2) the date specified in the warranty registration card that we ask you to send to us, or 3) if you don’t 
return the warranty registration card, 120 days after the date on which the Product was sold to the dealer 
from whom you bought the Product, as documented in our records. 

This warranty does not cover damage caused by: 1) handling during shipping, 2) use or maintenance 
contrary to labeled instructions, 3) alteration or repair by anyone not authorized by Welch Allyn, and 4) 
accidents. 

If a Product or accessory covered by this warranty is determined to be defective because of defective 
materials, components, or workmanship, and the warranty claim is made within the warranty period 
described above, Welch Allyn will, at its discretion, repair or replace the defective Product or accessory 
free of charge. 

You must obtain a return authorization from Welch Allyn to return your Product before you send it to Welch 
Allyn’s designated service center for repair.  

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. WELCH ALLYN’S OBLIGATION UNDER THIS WARRANTY IS LIMITED TO 
REPAIR OR REPLACEMENT OF PRODUCTS CONTAINING A DEFECT. WELCH ALLYN IS NOT 
RESPONSIBLE FOR ANY INDIRECT OR CONSEQUENTIAL DAMAGES RESULTING FROM A 
PRODUCT DEFECT COVERED BY THE WARRANTY. 
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1. Safety summary 

Introduction 
We at Welch Allyn are dedicated to provide safe products to our customers. It is the user’s responsibility to 
follow the rules of safety as established for their protection and for the protection of their patients as 
described in this manual.  

The hospital’s Biomedical/IT support staff shall require primary skills including disciplines related to 
maintenance and servicing computer controls/platforms. 

Please take note of all safety precautions and warnings provided with the devices before using the devices 
and the accompanying software.  

 
WARNING: The CardioPerfect family of devices is an integral part of a personal computer-based 
diagnostic system. The user shall adhere to warnings in order to ensure safe and reliable 
performance of the system. 
• The personal computer (non-medical electrical equipment) shall be situated outside the patient 

environment (reference IEC 60601-1-1).  
• The personal computer used should adhere to the appropriate safety standard for non-medical 

electrical equipment (IEC 60950, or its national variants), and use of an isolation transformer is 
recommended. 

• Normal isolation transformer does not fulfill the IEC601-1-1 standard and its supplement EEE 
requirements for transformer unit. To maintain operator and patient safety, consider the 
requirements of IEC 60601-1-1. Measure the leakage currents to confirm that no electric shock 
hazard exists. 

• The personal computer used should adhere to the appropriate electromagnetic compatibility 
(EMC) standard for non-medical electrical equipment (CISPR 22/24 - FCC Part 15 - CE, or 
related national variants).  

If it is required for the personal computer to be situated within the patient environment, it is the 
responsibility of the user to ensure that the system provides a level of safety in compliance with 
IEC 60601-1-1. 

 

Note: On computers that you plan to use for clinical procedures, disable automatic installation of 
Windows updates. 
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Symbols 
 

Documentation symbols 

 WARNING Indicated conditions or practices that, if continued or not corrected immediately, 
could lead to illness, injury, or death. 

 Caution Indicated conditions or practices that, if continued or not corrected immediately, 
could damage the equipment. 

 

Shipping, storing, and environment symbols 

 Single Use — Do Not Reuse 

 YYYY-MM 
Expiration date  

 
Keep away from sunlight  

 
Temperature Range  

 
Stacking limits 

 

Certification symbols 

 
Meets essential requirements of European Medical Device Directive 93/42/EEC 

 

Equipment symbols 

 
Serial Number 

 
Catalog Number 

 
Type BF Equipment 

 
Manufacture Date 

 
Defibrillation-proof type BF applied part 
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2. Overview 
Welcome to the Welch Allyn CardioPerfect® Workstation (CPWS), the medical diagnostic workstation that 
offers the next step for PC-based medical systems. CPWS includes the following features: 

• A database with virtually unlimited storage based on the Microsoft® SQL Server™ database software 

• The possibility to integrate different diagnostic tools  

• One framework for different diagnostic modules 

Note: All CPWS installations include the following free SQL licenses:  
• SQL MSDE 2000 can store up to 2GB of data (this accommodates approximately 1500 stress 

tests, depending on file size)  
• SQL Server 2005 Express can store up to 4GB of data.  

 You can purchase MS SQL licenses from Microsoft for versions that allow unlimited storage. 
 

This manual explains how to install and configure CPWS. For information about using CPWS, see the 
CPWS user manual. Module-specific instructions are in the user manuals of the applicable modules. 

Product configurations  
CPWS includes the following components: 

• Server (database): You use this component to store and view data sent from clients to this computer. 
Install only one server at your site. 

• Client (application): You use this component to run CPWS with one or more of the diagnostic 
modules. The client sends data collected by CPWS to the server. You can install one or many clients 
at your site. 

Before installing, determine how you want to configure CPWS: 

• Single-computer configuration: A stand-alone system on a single computer. 

 
• Network configuration: Installing a network configuration means that the server and client 

components are on different computers. They require an external connection to communicate with 
each other, typically a network. 

 
• Thin-client configuration: Clients can access the application via presentation applications such as 

Citrix ICA and Microsoft Remote Desktop Services (RDS).  
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For more information, see “Thin-client interface” on page 23. 

The Site Management Tool, a standalone application, provides central administration of site-related 
data. For more information about installing and using this tool, see “SiteManager” on page 45. 

CPWS components 
When you install CPWS, you can install the following components.  

Software CPWS client software. The license that you purchased determines which 
modules are activated. 

Database The CPWS database. 
Telemedicine server The Telemedicine server that you use to send and receive tests through e-mail 

or a direct TCP/IP connection. 
US defaults A set of default values specific to the US, such as 60Hz AC mains frequency and 

mph as the speed unit. 

When upgrading from a previous version your existing, customized settings are 
not overwritten. 

 

Drivers 
Most device drivers are automatically installed when you install the software. To manually install 
Spirometry and ProLink drivers, see Appendix A, “Installing legacy Unilink USB drivers.” 

Upgrades 
Note: The database is not compatible with older client software. When installing CPWS, you must 

upgrade all clients and the database. 
 Do not use CPWS software on any client workstations during this process. 
 

SpiroPerfect update 
In versions before 1.5.0, Spirometry’s predicted values were calculated differently than in newer software 
releases. Predicted values were calculated at the moment a Spirometry test loaded into the system, based 
on the Norm setting configured under Settings. As of version 1.5.0, the norm values are calculated at the 
moment the test starts, and the values are stored with the test. 
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When upgrading from pre-1.5.0 software, the installation process will optionally calculate the norm values 
for your Spirometry tests already in the database if it detects any Spirometry tests for which the predicted 
values can be calculated. The upgrade process tries to provide the best possible match between the 
pre-1.5.0 norm selection active on your system at the time of the upgrade installation, and the norms 
implemented in new software release, and prompts you to confirm the mapping. If no match is found, the 
suggested norm selection will be empty. You can use the norm suggested by the upgrade, select a 
different norm to use, or cancel the calculation of the predicted values. 

 
Caution: In some cases, the norm implementations differ in pre-1.5.0 versions causing differences 
in the predicted values after recalculation. Full details on the norm implementation differences are 
available upon request. 
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System requirements 
To work with CPWS software, you need the following minimum recommended configuration. 

Note: If implementing CPWS in a thin-client environment, see “Thin-client interface” on page 23. 
 

Item 
Resting ECG, ABP, 
Spiro, Recollect1,2 

Stress  
ECG1,2 

CPWS Server – 
small office1 

CPWS Server – 
enterprise1 

Configuration Tower or desktop PC 
preferred; laptop or tablet 

Tower or desktop PC Tower or desktop 
PC 

Server 

CPU P4 (or equivalent) 
or higher 

P4 (or equivalent) 
or higher 

P4 (or equivalent) 
or higher 

P4/XEON 
(or equivalent) 
or higher 

Hard disk 20 GB with 5 GB 
free space 

40 GB with 10 GB 
free space 

120 GB with 40 GB 
free space 

200 GB with 40 GB 
free space 
RAID 5 array or 
RAID array 
controller with 
memory backup 
recommended 

RAM 512 MB, 1 GB or higher 
recommended 

1 GB or higher  1 GB or higher 1 GB or higher 

Monitor 
resolution 

1024x768 true color, 
1280x1024 
recommended 

1024x768 true color 1024x768 
true color 

1024x768 true color 

Monitor size 15" or higher 17" or higher N/A N/A 

Ports 2 USB 3 USB and 2 serial N/A N/A 

Operating 
system3 

XP SP2 or later, Vista 
Business SP1 or later, 
Windows 7 Home 
Premium, Professional, 
or Ultimate 

XP SP2 or later, Vista 
Business SP1 or later, 
Windows 7 Home 
Premium, 
Professional, or 
Ultimate 

Windows Server 
2003, 2008, 
2008 R2; XP SP2 
or later; Windows 7 
(Home Premium, 
Professional, or 
Ultimate) 

Windows Server 
2003, 2008, 
2008 R2 

Peripherals Color printer recommended for Spirometry 
Compatible with inkjet and laser printers 

Printer optional 

1 An Internet connection is required for the Telemedicine option or to allow Welch Allyn to provide online 
technical support. 

2 A PC running only CPWS and EMR applications during tests. 
 If using CPWS software in a language other than English, select a numerical option for the Windows 

date format (under Regional Options). Formats that include month names are reliable only in the 
English version of the software. 

3 Both 32- and 64-bit operating systems are supported. 
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3. Install CPWS software 
Installing CPWS software also copies selected device drivers (for the ECG recorder and spirometer) to the 
hard drive.  

 
Caution: Connect USB devices only after the software is installed. Otherwise, drivers must 
be installed manually. 

 

1. Make sure that you have administrator rights. 

2. Close all running programs. Insert the CardioPerfect Workstation CD. The installer menu appears. (If 
this menu does not appear, explore the CD, and run installer.exe.) 

 

3. Select Install CardioPerfect Workstation. The installation wizard runs. Click Next, then click Accept 
to accept the software license agreement. 

 

4. Enter your registration details (you can find the serial number and release code on the CD case), and 
click Next.  
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5. Specify where to install the files.  

By default, files are installed in C:\Program files\Cardio Control\MDW. To specify a different location, 
click Browse. After specifying a destination, click Next. 

 

6. Select the components you want to install.  
For most US installations, that includes Software, Database, and US Default Settings, as shown in 
the previous figure.  

You do not have to use the SQL Server database provided with CardioPerfect software. If you already 
have a database, uncheck the Database option. 

 

7. Select the device drivers you want to install. If you are unsure which devices you need to support, 
check both boxes. 

• If SQL Server already exists on the target system, the wizard is ready to start the installation. Click 
Next. A Login dialog may appear. 
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Enter your System Administrator name and password, click OK, and go to Step 9. 

• If your computer does not have SQL Server, and if you checked the Database option in step 5, the 
wizard displays the database selection screen.  

 
8. Choose the database that you want to install and click Next:  

• MS SQL Server 2000 Desktop Engine (MSDE 2000) 
(Default) Select this option for Windows XP. 

• MS SQL Server 2005 Express 
Select this option for 64-bit operating systems, Windows Vista, and Windows 7. 

 
 
 
 

 
 

Only the options supported by your operating system are available for selection. 

9. Click Next. The wizard installs the software. This takes several minutes and depends on your 
computer’s speed. When installation is complete, click Finish. 

10. Restart the computer to finish the installation, if required. 

11. Click any other desired menu items, as described in the following pages. 

You can now use CPWS. 
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4. Install example data 
You can install example data in your database to experiment with. 

1. Close all running programs.  

2. Insert the CardioPerfect Workstation CD. The installer menu appears. (If this menu does not appear, 
explore the CD, and run installer.exe.)  

 

The file importer installs the example data. 

 

3. Press Quit.  
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5. Reinstall USB drivers 
To reinstall the USB drivers: 

 Caution: Connect USB devices only after the drivers are manually reinstalled.  
 

1. Close all running programs.  

2. Insert the CardioPerfect Workstation CD. The installer menu appears. (If this menu does not appear, 
explore the CD, and run installer.exe.)  

 

3. Select CardioPerfect Device Drivers. 

4. Select the drivers you want to install: 

• CardioPerfect PRO-Link USB drivers 

Note: If you have older CardioPerfect MD or Portable ECG hardware, see Appendix A, 
“Installing legacy Unilink USB drivers,” on page 47. 

 

• USB Spirometer drivers 

5. Follow the instructions on the screen. 
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6. Install Adobe Reader 
All user manuals on the CardioPerfect Workstation CD require Adobe Reader to read or print. If you do not 
have the reader, you must install it. 

Note: To download the latest free Adobe Reader, go to Adobe Reader download at 
http://get.adobe.com/reader/. 

 

1. Close all running programs.  

2. Insert the CardioPerfect Workstation CD. The installer menu appears. (If this menu does not appear, 
explore the CD, and run installer.exe.)  

 

3. Click 3rd Party Tools and Service Packs.  

 

4. Click Install Adobe Acrobat Reader (US).  
Follow the instructions on the screen.  

http://get.adobe.com/reader�
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7. Browse the user manuals 
All CardioPerfect user manuals are on the CardioPerfect Workstation CD in PDF format, and are 
downloaded to the install location you specified for the CPWS software.. 

Note: To open PDF files, you must have Adobe Acrobat Reader. If you do not have the reader, see 
“Install Adobe Reader” on page 17. 

 

1. Insert the CardioPerfect Workstation CD. The installer menu appears. (If this menu does not appear, 
explore the CD, and run installer.exe.) 

 

2. Click Browse the manuals folder. 

Windows Explorer displays the folder on the CD containing the manuals. Open the appropriate 
language folder and open the desired manuals.  
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8. View the Read Me file 
The Read Me file describes the contents of the CardioPerfect Workstation CD and includes last-minute 
information that was not included in the user manuals. 

1. Close all running programs.  

2. Insert the CardioPerfect Workstation CD. The installer menu appears. (If this menu does not appear, 
explore the CD, and run installer.exe.)  

 

3. Click View read me file. 
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9. Configure the ABPM module 
The ambulatory blood pressure (ABPM) module may require configuring for use with a Keyspan® USB 
serial adapter. 

Note: If your operating system driver is not on the Keyspan CD, you may need to go to the Keyspan 
website and download the driver. 

 

To configure the ABPM module for a USB serial adapter 

1. Install the Keyspan software. Follow the Keyspan instructions. 

2. Select Start > Programs > Keyspan > USB Serial Adapter. 

3. Select Keyspan Serial Assistant. 

4. Verify which COM port is assigned to the adapter. 

5. Click  to start CPWS software. 

6. Select File > Settings > Ambulatory blood pressure. 

7. Select Advanced. 

 

8. Match the COM port to the Keyspan Serial Adapter Assistant. 
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To configure the ABPM module for a USB serial adapter using Windows Vista or Windows 7 

1. Install the Keyspan software. Follow the Keyspan instructions. 

2. Select Start > Programs > Keyspan > USB Serial Adapter. 

3. Select Keyspan Serial Assistant. 

 

4. Click the Properties tab. 

5. Select Faster from the Transmit Completion Timing Advance drop-down menu. 

6. Click Update Configuration. 

7. Click Yes in the Keyspan Serial Adapter confirmation box. 

8. Click OK in the Device Configuration Update Complete Your Device is Ready to Use box. 

To configure the ABPM module for an RS232 cable 

1. Click  to start CPWS software. 

2. Connect the RS232 cable to an available CPU COM port. 

3. Select File > Settings > Ambulatory blood pressure. 

4. Select Advanced. 

5. Select the proper COM port. 
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10. Install additional options or features 

Install Telemedicine software 
Telemedicine is an optional extension to CPWS. Without the correct release code, the Telemedicine 
functionality will not be activated. 

With Telemedicine, it is possible to send and receive tests and interpretations to and from predefined 
contacts. This typically allows expertise sharing and second opinion consults, but might also be used for 
administrative purposes in situations where replication cannot be used.  

Telemedicine offers the following methods for sending and receiving email:: 

• Email facilities. 

• Direct communication, using TCP/IP sockets.  

In both cases, the Internet or any other TCP/IP network must be available as transportation infrastructure. 
You can use a mix of both email and direct socket connection. 

Telemedicine, like CPWS, is built using a client / server architecture. This means Telemedicine scales 
from use on a single standalone computer with a modem, to a configuration of multiple client computers, a 
MSSQL database server and a telemedicine mail server working together in a LAN network. 

Before installing Telemedicine, make sure that the hardware and software requirements are met (see 
“System requirements” on page 11), determine the type of communication you will use and, if in a network, 
identify which computer(s) will run as clients and which as mail server. 

The Telemedicine option requires significant IT skills to install and configure. Detailed instructions on 
installation and configuration can be found in Section 10 of the CardioPerfect Workstation Service and 
Advanced Installation manual. 

For a more detailed description of how to use Telemedicine, see the CPWS user manual. 

Note: Full administrator privileges are required to correctly configure Telemedicine.  
 



 
 CardioPerfect Workstation
  

 

DIR 80013928, Ver. D  23 / 59 

 

11. Thin-client interface 
If you plan to operate the CPWS in a thin-client environment, install the Welch Allyn PerfectLink® ECG 
client on the client PC. Clients can access the application via presentation applications such as Citrix ICA 
and Microsoft Remote Desktop Services (RDS).  

 

Device data acquisition through a thin-client interface requires the following: 

 Resting ECG and Spirometry: The Welch Allyn PerfectLink thin-client solution. 

 ABPM: A serial interface. With the serial interface, the system administrator can configure your 
system to share the serial port over the network between the server and the clients. 

Thin-client system requirements 
To work with CPWS software in thin-client environment, you need the following minimum recommended 
configuration: 

Item Resting ECG Spiro ABP Server 

Configuration Tower or desktop PC 
preferred; laptop 
or tablet 

Tower or desktop PC 
preferred; laptop 
or tablet 

Tower or desktop PC 
preferred; laptop 
or tablet 

Tower or desktop 
PC 

CPU P4 (or equivalent) 
or higher 

P4 (or equivalent) 
or higher 

P4 (or equivalent) or 
higher 

P4 (or equivalent) 
or higher 

Hard disk 5 MB free space 5 MB free space 5 MB free space 120 GB with 
40 GB free space 

RAM 512 MB, 1 GB or 
higher recommended 

512 MB, 1 GB or 
higher recommended 

512 MB, 1 GB or 
higher recommended 

1 GB or higher 

Monitor 
resolution 

1024x768 high color, 
1280x1024 
recommended 

1024x768 high color, 
1280x1024 
recommended 

1280x1024 high 
color, 1280x1024 
recommended 

N/A 

Monitor size 15" or higher 15" or higher 15" or higher N/A 

Ports USB USB or serial USB or serial N/A 

Connection 
technology 

PerfectLink PerfectLink COM port forwarding N/A 
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Item Resting ECG Spiro ABP Server 
Operating 
system¹ 

XP SP2 or later, XP 
embedded, Vista 
Business SP1 or later, 
Windows 7 Home 
Premium, 
Professional, or 
Ultimate 

XP SP2 or later, XP 
embedded, Vista 
Business SP1 or 
later, Windows 7 
Home Premium, 
Professional, or 
Ultimate 

XP SP2 or later, Vista 
Business SP1 or 
later, Windows 7 
Home Premium, 
Professional, or 
Ultimate 

Windows Server 
2003, 2008, 
2008 R2 

Peripherals Color printer recommended for Spirometry 
Compatible with inkjet and laser printers 

 

¹ Both 32- and 64-bit operating systems are supported. 

Before you begin 
• Make sure that you have administrator rights for this computer. 

• Close all programs before starting the installation. 

Configure the CPWS server 
Install CPWS on the server as described in “Install CPWS software,” starting on page 12. It is not 
necessary to install drivers for the acquisition devices on the server. 

Although the installer may handle this on its own, it is good practice when installing new software on a 
version of Windows Server to switch to “Install Mode” before installing CPWS or any of its components. 
This can be accomplished by typing the following command in the command prompt: 

change user /INSTALL 

After installing CPWS and its components, you can exit Install Mode by entering the following command: 

change user /EXECUTE 

You can get the current status by entering this command: 

change user /QUERY 

This applies only to systems with Terminal Services installed or configured when operating in “Application 
Mode.” If in Remote Administration mode (the only mode available if Terminal Services is not installed), 
this has no effect. 

Configure thin clients for ECG and Spirometry 
1. Close all running programs.  

2. Insert the CardioPerfect Workstation CD. The installer menu appears. (If this menu does not appear, 
explore the CD, and run installer.exe.)  
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3. Click CardioPerfect Connectivity Tools, then click Install PerfectLink thin client support.  

The Welcome screen appears. 

4. Click Next.  

5. Start a thin-client remote session. Within CardioPerfect running in the remote session: 

a. Navigate to the Settings dialog, then the ECG section and the Recorder tab.  

b. Select PerfectLink as the port to use.  

c. In the Spirometry section, go to the Recorder tab.  

d. Select PerfectLink in the “Connect to” dropdown list. 

Note: If you plan to connect the USB PRO ECG or Spiro USB/Serial recorder to several thin-client 
PCs, install PerfectLink on each thin client. PerfectLink enables the remote server to see 
USB-connected devices.  

 

Configure thin clients for ABPM 
This procedure applies only to ABPM.  

To connect ABPM devices, enable COM port forwarding through RDP or Citrix.  

• Microsoft RDP COM port forwarding. If you use Remote Desktop services (using the RDP protocol), 
you can select from the options in the Terminal Services Client. 

a. Open Remote Desktop Connection. 

b. Select Options to expand the dialog. 

c. Navigate to the Local Resources tab. 

d. If Serial devices is not present on this page, select More. 

e. In the Local devices and resources list, check Serial ports. 

f. Click OK and connect to the remote computer. 
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• Citrix ICA COM port forwarding.  

If you use Citrix (ICA), you map the serial port from the server using the following command: 

net use comx: \\client\comz:  

where x is the server COM port and z is the client COM port. Note that client is not replaced by the 
client workstation name; it is the word “client”. 

For NFuse implementations, you may need to change the template.ica file from COMAllowed=NO to 
COMAllowed=Yes 

For detailed information about enabling COM port forwarding, see documentation from Microsoft or 
Citrix. 

• Citrix serial port sharing configuration: In the Citrix Program Neighborhood window (the window 
containing Citrix connections) use the menu system (the Tools menu) to select configuring serial 
devices. Proceed through the prompts to add a serial port to share through the client. After adding a 
serial port, devices connected on the client are available to CPWS on the server. For details on 
configuring shared serial ports, see the Citrix user documentation. 
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12. About the database 
CPWS can use these database engines: 

• Microsoft SQL Server 2008 R2 and Microsoft SQL Server 2008 R2 Express 

• Microsoft SQL Server 2008 

• Microsoft SQL Server 2005 and Microsoft SQL Server 2005 Express 

• Microsoft SQL Server 2000 

• Microsoft SQL Server 7 

• Microsoft MSDE database (a runtime version of MS SQL Server 7 / 2000) 

Note: To use with CardioPerfect, existing SQL Server installations must have mixed-mode 
authentication enabled. 

 The Microsoft MSDE database is available only if no default instance of the SQL Server exists on 
the system prior to installing CPWS software. 

Database installation 
The database installation process installs either the Microsoft MSDE database engine or the Microsoft 
SQL Server 2005 Express Edition, depending on your installation selection, and creates a database 
named ccdb in an instance named CARDIOPERFECT. This database contains all information generated 
by CPWS. A second database called ccdb_audit is installed for maintaining an audit trail when enabled.  

Start the Microsoft SQL 2000 server 
To work with CPWS, the database engine (or MS SQL server) must be running. By default, the database 
engine (or MS SQL Server) starts automatically when you start the computer. However, you can also 
manually start the SQL server. 

1. Click Start and point to Programs. 

2. Point to the MSDE (or MSSQL7 or MSDE SQL Server 2000) folder and click Service manager. The 
SQL Server Service Manager appears. 

3. From the Services list, select MSSQLServer. 

4. Click Start/Continue to start MS SQL Server.  

You have successfully started the MS SQL Server when the SQL Server Service Manager icon 
displays a green triangle instead of a red square. 

 
MS SQL Server is running 

 
MS SQL Server is not running 
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Start SQL Server 2005 Express Edition 
1. Click Start and point to All Programs. 

2. Point to the SQL Server 2005 folder and click Configuration Tools folder and select SQL Configuration 
Manager. The SQL Server Service Manager appears. 

3. From the Services list, select SQL Server 2005 Services. 

4. Select SQL Server (CARDIOPERFECT), point to the Action button, and select Start. 
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13. Before configuring CPWS 

Security 
CPWS has a security mechanism that can be used to prevent certain users to take certain actions. 

You can control: 

• The users that access CPWS. This is done through user accounts and passwords. 

• Actions users can perform with CPWS. This is done by assigning each user a role. Each role can only 
perform a predefined set of actions. 

Access and action control can be configured with the user administration functionality in the 
Administrator tool. 

Authentication types 
Authentication is performed through the login process. When logging into CPWS, a user must provide a 
password as proof of identification.  

CPWS can use these types of user authentication: 

• NT authentication 

• Database authentication 

• Anonymous 

NT authentication 

NT authentication takes advantage of Windows NT user security and account mechanisms. Users with 
a valid NT account can start CPWS without entering a user name and password. Instead, the Windows NT 
user name and password are used. So, you can control access to Windows NT and CPWS with just one 
user account.  

Database authentication 

Database authentication uses CPWS security system.  

Anonymous authentication 

At log-on, there is a third option called “anonymous.” You can use this only if the “ccguest” account exists. 
Anonymous access should in general be avoided and may be illegal according to local regulations. On 
systems with HIPAA support, anonymous access is disabled. 

Windows NT authentication properties Database authentication properties 
Windows 2000 / XP Windows 2000 and XP 

One user name and password for both OS 
and CPWS  

One user name and password for OS 
One user name and password for CPWS 
(validated by the SQL server) 

No login screen at startup (optional) Always a login screen at startup 

Password aging and login auditing No password aging or login auditing 

User accounts are assigned the role “User” by 
default. The system administrator configures 
user rights. 

System administrator assigns and configures user 
roles and rights 

User name format: domain\user_name User name format: any format or character, except \ 
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Accounts 
CPWS includes the following user accounts with special privileges: 

• Admin account 

The Admin account is a CPWS user account that gives access to workstation functionality that can 
only be used by the system administrator, such as the Administrator tool.  

The Admin account can perform every possible action. To prevent abuse, change the password of this 
account after installation. 

• SA account 

The SA account is an MSDE server administrator login that gives access to functionality related to the 
database. 

By default, the SA account password is Cardio.Perfect.  

To prevent abuse, change the password for this account after installation. 

A word on HIPAA 
As of April 2003, the Privacy provisions of the US Health Insurance Portability and Accountability Act of 
1996 are mandatory for all entities except small health plans. Among other things, HIPAA requires all 
repositories of Healthcare Information to provide access only to authorized individuals and to maintain an 
audit trail of activity performed with that data. 

Welch Allyn CardioPerfect keeps track of this audit trail in a separate database called ccdb_audit which is 
installed during set-up. When upgrading from an older version, the audit database may not yet exist. Upon 
detecting this situation, CPWS prompts you to run the dbbuilder tool to correct this situation.  

The HIPAA mode can be switched on and off from the Administrator tool. For more information, see 
“HIPAA audit functions” on page 38. 

Additional functionality of HIPAA-mode 

• Audit trail of log-ins and attempted logins 

• Audit trail of data access, change, deletion, print-out, import and export of patient and test data 

• Anonymous access is disabled 

• Inactivity time-out; after not using CPWS for a period of time, it requires reentry of your password to 
reactivate the program  

Considerations for system administrators 

In the HIPAA Settings of the Administrator tool, CPWS adds security features and audit functionality to 
enable a fully HIPAA-compliant environment.. In addition to this basic functionality, the overall system 
configuration must also provide for measures such as security policies on passwords (for example, 
password complexity and aging). We strongly recommend using NT authentication along with the security 
policy enforcement that the NT Server provides. 



 
 CardioPerfect Workstation 
  

 

DIR 80013928, Ver. D  31 / 59 

 

14. Administrator tool  
Use the Administrator tool to perform user and data administration, and to back up the database. 

1. In the Windows Start menu, select Programs > Welch Allyn > Administrator Tool.  

2. Enter your password. The Administration Tool screen appears.  

 

The main window contains the following elements: 

Functionality categories  
 You can access the following categories of administrator functions from this pane: 

• User Administration  
• Application Administration  
• Telemedicine 
• HIPAA Auditing 
• Database Administration 
From these categories, you can select various administrator tasks. 

Workspace You perform administrator tasks in the workspace, located in the right pane. 
 

14.1  User accounts 
1. Start the Administration Tool. 

2. Select User administration in the left pane. 
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Create an account 
1. Click New User under Users. The Edit user information dialog box appears. 

 

2. In the Edit user information dialog box, enter the user name for the user that you want to add. 

If you use... Then the user name format is...  

NT authentication DOMAIN\user name. 

Database authentication Any name with any characters except \. 
 

3. Enter a user password. If you use NT authentication, you cannot enter a password because the NT 
password will be used. 

4. Select a role for the user.  

5. In the Personal Information tab, enter the user’s personal information. 

Notes: 
• When you do not enter a password for database authentication, users can log in to CPWS without 

supplying a password. 
• When you use database authentication, users can change their password in CPWS.  

 

Deactivate an account 
When you want to prevent an end user from working with CPWS (for instance, because you want to delete 
the user in the near future and want to prevent him or her from accessing the data), you can deactivate 
that user.  

When you deactivate a user, the user account is not deleted, but made inactive. The user can no longer 
access CPWS. 

1. Make sure the user is not currently logged in. 

2. Click Users. 

3.  Click the user that you want to deactivate or reactivate. 

4. Click one of the following: 

Make inactive The user account is deactivated and the user cannot access CPWS. The 
user account still exists.  
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Make active The Edit user information dialog box appears. 
If you use database authentication, enter a new password for the user. The 
user is reactivated immediately. 

 

Delete an account 
You can delete a user only when there are no tests in the database that were recorded or interpreted by 
that user. Since most users have recorded tests, this normally means that you cannot delete a user. In 
such cases you need to de-activate the user. An inactive user cannot work with CPWS. 

1. Click Users. 

2. Click the user that you want to delete. 

3. Click Remove user. The user is deleted. 

Assign a role 
With database authentication, roles are not automatically assigned. For the security system to work, you 
must assign these roles. 

With NT authentication, every user is, by default, assigned the role of User. For the security system to 
allow extended access, you must change these roles. 

1. Under Users, click the user whose role you want to change. 

2. Click Edit user. The Edit User Information dialog box appears. 

3. Select one of the following roles: 

• Technician 

• Physician 

• User 

• Administrator 

Grant rights 
CPWS comes with four sets of user rights, one for each user role. However, you can change these user 
rights. Note that you cannot change user rights at the user level. You can only change user rights at the 
user role level. 

1. Click User rights. 

2. In the User rights matrix, locate the user role column for which you want to change the rights. 
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3. Determine whether to allow each action: 

 (Checked) Users assigned this role can perform the action. 

 (Unchecked) Users assigned this role cannot perform the action. 

Note: You cannot edit the right to change security settings for administrators; administrators always 
have this right to make sure there is always someone that can access the system. 

 

Set up a password 
When you use database authentication, you can reset a user password with a new password. You can 
use this function, for example, when end users have forgotten their password.  

1. Click Users. 

2. Click the user for which you want to change the user password. 

3. Click Edit. The Edit User Information dialog box appears. 

4. Enter a different password. 

Hide the login window at startup 
When you use NT authentication, you can choose to hide the Login window for the end user. When you do 
this, CPWS automatically uses the NT user information and bypasses the login screen. 

1. On the client, start CPWS and wait for the Login window to appear. 

 

2. In the Login window, select Always use above login settings. 

14.2  Physicians 
CPWS uses predefined lists of physicians, specialties, and locations that are maintained on the server. 
This way, all clients that are connected to the same server have the same information available. 

1. Open the Administration Tool. 

2. Select Application Administration. 

3. Select the table you want to configure. 

Configure the physicians list 
Select Physicians. 
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Add a physician 
1. Click New Physician. The Physician dialog box appears. 

 

2. Select the Specialty to which you want to link the physician and enter the information of the physician 
that you want to add. 

Edit a physician 
1. Click the physician that you want to edit. 

2. Click Edit. The Physician dialog box appears. 

3. Edit the physician information. 

Delete a physician 
Important: You can only delete a physician when there are no tests linked to that physician. 
 

1. Click the physician that you want to delete. 

2. Click Delete. The physician is deleted. 

14.3  Specialties  

Configure the specialties list 
Select Specialties. 

Add a specialty 
1. Click New Specialty. The Add Specialty dialog box appears. 

 

2. Enter the name of the specialty that you want to add. 
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Edit a specialty 
1. Click the specialty that you want to edit. 

2. Click Edit. The Edit Specialty dialog box appears. 

3. Edit the name of the specialty. 

Delete a specialty 
Important: When you delete a specialty, you also delete it for all physicians who are linked to 

that specialty. 
 

1. Select the specialty that you want to delete. 

2. Click Remove Specialty. The specialty is deleted. 

14.4  Locations 

Configure the locations list 
Select Locations. 

Add a location 
1. Click New Location. The Add Location dialog box appears. 

 

2. Enter the name of the location that you want to add. 

Edit a location 
Important: When you change the name of a location, it is automatically changed everywhere in the 

system, including existing tests. 
 

1. Select the location that you want to edit. 

2. Click Edit. The Edit Location dialog box appears. 

3. Edit the name of the location. 

Delete a location 
Important: When you delete a location, you also delete it for all tests that are linked to that location. 
 

1. Select the location that you want to delete. 

2. Click Remove Location. The location is deleted. 
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14.5  Patients 

Access the patient list 
CPWS maintains a list of patients on the server.  

Under Application administration, click Patients. 

 

Delete a patient 
Only someone with system administrator rights can delete a patient from CPWS in the Administrator tool.  

 
WARNING: When you delete a patient, you delete all the patient data from the database. If there 
are tests in the database for this patient, these tests are deleted! 

 

1. Find the patient that you want to delete. 

2. Click Delete.  

14.6  Tests 

Transfer a test 
One mistake that can occur is recording a test for the wrong patient. With the Administrator tool, you can 
correct this by transferring a test from one patient to another. 

1. Find the patient for whom the test was mistakenly recorded. 

2. Click Transfer test. The Transfer test dialog box appears. 
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3. Select the test you want to transfer. To select several tests, press and hold the Shift key. 

4. Find the patient to whom you want to transfer the test with the Search button and select that patient 
by clicking the name. 

5. Click Transfer. The tests transfer to the selected patient. 

14.7  HIPAA audit functions 
You can modify the HIPAA-related settings in the HIPAA section of the Administrator tool. 

HIPAA settings 
In the HIPAA Settings screen, the following items can be modified: 

• HIPAA On and Off Switch: Switches HIPAA mode on or off 

• Empty Audit Database: Use this to purge the audit trail. 

• Screen Lock Timeout setting: Sets the number of minutes of inactivity allowed before the program 
locks. Once locked out, you must re-enter the password to regain access. 

• Login Attempts: Sets the number of unsuccessful login attempts allowed before a security log event 
is generated.  
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HIPAA Audit log viewer 
The audit log entries generated as users access CPWS can be viewed with the Administrator tool under 
the Audit Log function. You can either choose to view all audit log entries (default), or you can enter 
certain criteria for selecting specific kinds of audit log events, like Security or actions performed by a 
specific user. 

 

14.8  Database functions 
In a computer environment, there is always a possibility that something goes wrong: database tables may 
be lost or corrupted. To limit the possible risk of data loss you should back up your database regularly. 

With the Administrator tool you can make a full backup your database. During the backup, copies of the 
database and the transaction log are made. These copies can be used to restore the database after the 
database has become corrupt or is lost during a catastrophic event.  

You can back up a database in the following ways: 

• Manually: The simplest way to back up the database. You can manually back up the database at any 
time you want.  

• Automatically: A backup or a series of backups at a fixed date and time. To back up the database 
automatically you must schedule a backup.  
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Access database functions 
In the Administration tool, select Database Administration.  

Create a backup device 
Before you can back up the database, you need to create a backup device. A backup device, a place to 
store the backup, can be a file on your hard disk or network drive, or a tape.  

We advise you to create a backup device on a different hard disk than the one that contains the database. 
If you do not do this, you run the risk of losing both your database and your backup copy if your computer 
crashes. 

1. Click Backup database.  

2. Click Add device. The Backup device dialog box appears. 

 

3. Enter the name of the backup device. 

4. Select the device type. 

If you select... Then... 
Disk Select the location where the backup is created and enter a filename. When you 

select a network drive, make sure you have the proper permissions to access the 
backup directory and file. 

Tape Select the tape and enter a filename. Make sure that the tape drive is connected to 
the computer that runs SQL server. 
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Make a manual backup 
The simplest way to create a backup is to create one manually. You can do this anytime you want; end 
users do not have to log out. 

Before you can make a backup, you need to create a backup device. 

1. Select Backup database.  

 

2. Enter a name and a description for the backup. 

3. Select the backup device to which you want to back up the database. 

4. Select the type of backup that you want to make. 

If you select… Then… 
Append to media The backup is added to the already existing backup on the selected backup 

device. 
Overwrite existing 
media 

The backup overwrites the already existing backup.  

 

4. Click Start Backup to start the backup process. 

Schedule an automatic backup 
If you want to make automatic backups of the database, you need to schedule the times at which the 
backup is made. You can schedule a single backup, or a recurring backup. 

Note: This feature is not available in SQL Server Express 2005. 
 

Important: Make sure that the computer is switched on at the time you scheduled the backup. Also 
ensure that SQL Server Agent is running. 

 

1. Click Backup database. 

2. Select the Schedule check box and click Change. The Schedule backup dialog box appears. 
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3. Select the backup device and backup type you want to use and click Next. 

4. Select whether you want to schedule a single backup or a recurring number of backups. 
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If you select... Then... 
Once Enter the date and time at which the backup must be made and click Next.  
Recurrent Enter the recurrence pattern and click Next. 

If you scheduled a recurrent backup, depending on which option was selected one of 
these dialogs appears: 

 

 
Days 

 
Weeks 

 
Months 

 

6. Enter the preferred schedule in the next steps. Click Next. 

7. A summary shows details of the backup schedule. Verify that this information is correct and click OK. 

Restore the database 
Restoring is the process of recovering a damaged, corrupt or missing database. Several situations can 
arise that might require the recovery of the database. 

Prior to the recovery of the database, evaluate the situation carefully. What is wrong with the database 
and what is the date of the most recent database backup?  

Important: When restoring a database, you can only recover the database to the point of the latest 
backup. Any changes made to the database after the last backup will be lost. 

 

1. Make sure that all users are logged out. You cannot restore the database while it is being used. 

2. Under Database Administration, click Restore database. 

 

3. Select the backup that you want to restore. If you have moved your backup files to a different location, 
use the Change File button to locate the backup files. 

4. Click Restore. A warning appears.  

5. Click Yes to start with the restore process. When the restore process is successful, a message 
appears. 
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15. SiteManager 
CPWS now includes sites, a way to group users that log in to the same server but belong to different 
practices, offices, or other administrative units. All users assigned to a site have the same settings for the 
database connection, license information and available plug-ins. 

You use SiteManager to manipulate these settings, and to create and maintain site definitions. You can 
add, update, and remove sites. SiteManager is available in the CPWS main installation directory. To use 
SiteManager, you must have Administrative privileges. 

To set up SiteManager: 

1. In SiteManager, define one or more sites. The CardioPerfect server changes to Site mode. 

 
2. In CPWS: 

A. Assign each user to a site. Users can now log in to CPWS.  

B. In CPWS, set up how users specify a site when logging in: 

• (Default) Select a site from a drop-down menu on the login screen. 

• Specify a site in the the user's login script.  

To specify a site, navigate to the following in the user’s registry: 

HKCU\software\cardio control\mdw\ConnectionString 

Change the following registers to the values shown: 

name: DefaultSite 
type: REG_SZ 
value: SiteGUID 

Note: The value for SiteGUID must be the same as the key under which the site was 
generated in HKLM\software\cardio control\mdw\Sites. 

• Specify a site in the the user's login script and hide the site selection field in the login screen. 

To specify a site, see the previous bullet. To hide the site selection field, navigate to the 
following in the user’s registry: 

HKCU\software\cardio control\mdw\ConnectionString  

Change the following registers to the values shown: 

name: DontAllowSiteSelection 
type: REG_DWORD  
value: 1 
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16. OS-specific installation instructions 

Windows Server 2003 and Server 2008 
By default, standard Windows users cannot perform spirometry calibration because they do not have the 
necessary permissions to edit certain registry keys.  

Grant access to users who need to make changes to the local machine registry: 

• HLKM\Software\Cardio Control\ 

• HKLM\Software\Spirometry\D9W\ 
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A. Ins ta lling  legacy Unilink USB drivers  
If you use a CardioPerfect Portable or CardioPerfect MD device connected through USB, you will need to 
install the Unilink USB drivers. The standard driver supplied with the system will support the PRO recorder 
only.  
 

To install or reinstall Unilink USB Drivers 

1. Close all running programs.  

2. On the CDROM, navigate to Drivers\PROLink-UniLink Usb\Legacy.  

3. Indicate your ECG device connector: Unilink USB for legacy CardioPerfect ECG recorder models and 
click Next. 

 
4. Click Next to start the installation of the driver.  

5. Click Finish. 
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B. Ins ta ll CPWS from the  Windows  Active  Direc tory 
Installation notes 

• See “System requirements” on page 11 before beginning installation. 

• Make sure that Windows Server with Active Directory and Group Policy Management is enabled. 

• Make sure that workstations are members of the domain network. 

• If your client PC is running Windows Vista, make sure that UAC is turned off during the remote install. 

Installation steps 
The installation consists of the following major steps: 

• Initial preparation 

• Creating the active directory organizational unit 

• Moving users to the organizational unit 

• Creating a new Group Policy Object (GPO) 

• Assigning a GPO to a group of users 

• Assigning an image to the group policy 

• Starting the install on a Client PC 

• Device driver association 

Initial preparation 
1. Insert the CPWS installation CD into the PC’s CD drive. 

2. If autorun starts, press Exit to exit the installer. 

3. Copy the CPWS installation image from the installation CD to a network location that all users in the 
domain can access. 

4. Run InstallServerSetup.exe. 
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5. Enter the following: 

Domain Administrator 
Information 

Enter a user name password and domain name. 
The user name must have sufficient administration rights to install software 
on the computers in the domain. If you don’t provide any information in the 
domain administrator section, the domain users must have enough rights to 
install software. 

Database Server Enter the server name and database to which CPWS software should 
connect. 
If you leave this section blank, the installer uses default settings. 

Registration Enter the serial number and release code from the purchase of your CPWS 
software. 
If you leave this section blank, CPWS prompts you to enter this information 
the first time CPWS launches. 

 

6. Press Save. 

7. Press OK. 
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Create the active directory organizational unit 
These steps create a specific CPWS user group. 

1. Go to the Active Directory Users and Computers window and find the organizational unit where you 
want to install CPWS. 

 If no organizational units exist in your domain, you can create a new one and add users to this group 
for whom you want CPWS installed. 

 The next figure shows how to create a new organizational unit called CPWS-ECG for the domain 
cpws.local. 
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Move users to the organizational unit 
To add users to the created users group: 

1. Go to Active Directory Users and Computers. 

2. Go to the Users folder. 

3. Select the users you want to move to the new organizational unit. 

4. Right click and select move. 

5. Select the group as shown in the next figure. 
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Create a new Group Policy Object (GPO) 
To support CPWS installation based on a specific user group, complete the following steps. 

1. Go to Group Policy Management from administrative tools. 

2. Select Domains > cpws.local > Group Policy Objects. 

3. Right click and select New. 

4. Enter a name for the GPO. 

 

5. Press OK. 
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Assign a Group Policy Object (GPO) to a group of users 
1. Select Domain > cpws.local > CPWS-ECG. 

 

2. Right click and then select Link an Existing GPO. 

3. Select the new GPO. 
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4. Click OK. 
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Assign an image to the group policy 
1. Go to Group Policy Management. 

2. Select Group Policy objects. 

3. Edit the GPO you just created (InstallCPWS) by right clicking the Group Policy and selecting Edit. 

 The Group Policy Object Editor window appears. 

4. Select User Configuration > Software Settings > Software installation. 

5. Right click and select New/Package. 

 

6. Select the MSI package and browse to the network location where you copied the CPWS 
installation image. 

Note: You must select the “CPWS Remote Setup.msi” package from the network location rather 
than the drive letter because the network path is accessible from the client PC whereas the 
drive letter may not be accessible. 
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8. Select the installation type. 

9. Click Open. 

10. Select Assigned. 
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11. Right click the Software Installation object you just created and select Properties. 

12. From the deployment tab, check the Install this application at logon checkbox and click OK. 

 

The Server installation and setup is now complete. 
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Start the install on a client PC 
After configuring the CPWS software deployment, log in to a client computer. 

Note: The installation takes place before you see the desktop after logging in. 
 

Device driver association 
1. For new installations of CPWS, the Found New Hardware Wizard dialog box may launch when a 

USB device is connected after the software installation. 

Note: If you connect a ProLink USB, the drivers automatically install. 
 

2. If the user does not have Administrator rights to install the hardware, enter the admin password to 
complete the installation. 

 

The drivers install. 
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